Fixed-Wing Mission Editor

For use with MiG-29 Fulcrum and F-16 Multirole Fighter by NovaLogic

About the Mission Editor Tool

This Mission Editor tool is a slightly modified version of the actual tool used by NovaLogic Mission Designers. Although some of the campaign programming has been disabled, you will find this tool extremely flexible when it comes to designing single player Quick Missions. This manual will only cover the basic requirements for successfully creating a mission. Because mission design has so many complex components, this tool is intended for the advanced user. Use at your own risk.

Table of Contents

Section 1: Navigating the Tool 2
Section 2: Creating a New Mission 3
Section 3: Forming Waygroups & Taxigroups 4
Section 4: Placing Objects 7
Section 5: Editing Mission Details 11
Section 6: Saving & Exporting Missions 12
Section 7: Hints and Tips 13
Section 8: Error Messages 14

Appendix A: Formations 15

To further assist you, a sample mission has been included to use as reference material. With the Mission Editor, you can open and alter the sample.prj file, or you can play it as a user created mission in the Quick Mission screen of the game.
1: Navigating the Tool

There are a number of keyboard controls and toolbar buttons that will help to create missions more efficiently. Use the mouse to select items on the map. Placing the mouse over any item you created will change its icon to a box with a dot in the middle. You can either Edit (Left Click) or Move (Right Click and hold) the current selection. If the selection box does not appear, try zooming in closer to the item.

Alt G  
Press ALT and the G key at the same time to toggle the grid on and off.

Arrow Keys  
Use the keyboard arrow keys to scroll the map 1/8 of a screen.

Page Up  
This key scrolls one full screen up.

Page Down  
This key scrolls one full screen down.

Home  
This key scrolls one full screen left.

End  
This key scrolls one full screen right.

Plus (+)  
This key will zoom in to double the current zoom ratio

Minus (-)  
This key will zoom out to half the current zoom ratio.

Zoom Extends – changes the zoom ratio to fit the entire map on your screen

Zoom to Window – after clicking this button, draw a box with the move and you will zoom to the contents of the box.

or (Ctrl + S) Select Mode – use this mode to select and move groups of items.

or (Ctrl + O) Object Mode – use this mode to place, edit or move objects.

or (Ctrl + W) Waypoint Mode – use this mode to place, edit or move waypoints.

or (Ctrl + T) Taxipoint Mode - use this mode to place, edit or move taxipoints.

The Information Bar

At the bottom of the tool, the info bar displays useful numbers including the current X/Y coordinates of the mouse and the current zoom factor (Z) of the screen.
2: Creating a New Mission

**Step 1:** Select **New Project** from the **File** menu

**Step 2:** Select one of the map templates.

**Step 3:** In Object Mode (`Ctrl + O`), place the cursor where you want your player to start and left click. The best place to takeoff from is a runway (marked as green dots)

**Step 4:** When the Edit Object window pops up, change only the following settings:

- Group/player ID = 0
- Format = **Active**
- Type = **Player**
- Precise Height = **checked**

**Step 5:** Click on **A.I.** and alter only the following settings:

- Object Type = **Air**
- AI Type = **F16** (or **MIG29**)
- Group = **VIPER** (or **300**)
- Rank = **Leader**

**Step 6:** Hit **OK** and **OK** again. You have just made the player. Feel free to move the player around by right clicking the mouse on it.

**Step 7:** Now you need to place some Waypoints for your player’s navigational computer/autopilot. Before you can begin, you must create a Waygroup by selecting **New Group** under the **WayPoint** Menu.

**Step 8:** Select **Player Waypgroup**. You are now ready to start laying down waypoints for your player.

**Step 9:** In Waypoint Mode (`Ctrl + W`), place your first Waypoint by left clicking the mouse somewhere on the map.

**Step 10:** Place a couple more down. They will automatically connect to the previous one. On the second to last one, change the Command Type to **Initial Approach**. Change the last one to **Final Approach**. These should lead back to the runway.

You are now ready to begin placing enemies, selecting mission loadouts and deciding on mission goals. Don’t forget to save your work often. Mission Designers will typically keep several backups of their files just in case they make mistakes or corrupt their current file.
3: Forming Waygroups & Taxigroups

It is usually a good idea to set up some waygroups and taxigroups before you begin placing objects. Aircraft and moving ground objects follow Waypoints that you define. Aircraft preparing to takeoff from the ground follow Taxipoints. Objects will only follow the path that they are assigned to.

Waygroups

To create a new Waygroup, select New Group under the Waypoint menu. Select Player Waygroup only to create waypoints for the player. In all other cases, select AI Waygroup. Before you select another New Waygroup, place a waypoint on the map. This will establish the current waygroup. You can always move it or add to it at a later time.

Waypoint Group # - number is used to assign waygroups to aircraft and moving ground objects in their AI Options

Waypoint # - the sequential order of the waypoints in this group.

Height (in feet) - sets the height that the player’s autopilot or the AI-controlled plane will fly at when it gets to this particular waypoint. Select from the list or type on your own number. Ground objects will ignore this value.

Command Types - actions that the object will do once it reaches this waypoint. Different commands exist for Player Waypoints and AI Waypoints.

The following commands are for the Player:

Follow Route - “Follow route” will be displayed on your HUD next to the waypoint.

Escort Route - displayed on your HUD.

Initial Approach - displayed on your HUD. (Second to last waypoint must be Initial Approach. Place 4-6 grid tiles from the landing strip with height of around 2000 feet.)
**Final Approach** - displayed on your HUD. (Last waypoint must be Final Approach. Place 1-2 grid tiles from the landing strip with a height of around 1000 feet. Be certain it comes from the proper approach direction.)

**Protect Friendlies** - displayed on your HUD.

**Attack Specific target** - does not apply to the player.

**Attack Flight Group** - displayed on your HUD. If you select this, it will ask you for a parameter. Choose the name of the flight group that you want to come after “attack flight group” that is displayed on your HUD. For example, if you select Bravo as your parameter, then the following will appear on your HUD: “Attack Flight Group: Bravo”

**Attack Ground Group** - the same logic applies here. The only difference here is that you’re using ground group names.

---

The following command types are for AI-controlled planes or moving ground objects:

**Goto Next Waypoint** - tells the object to continue to the next waypoint.

**Goto Specific Waypoint** - tells the object to redirect to the waypoint you assign in parameters. Telling the object to redirect to Waypoint #0 is a great way to have the object move in a looping patrol route or CAP. The last AI Waypoint must be Goto Specific Waypoint.

**Obsolete** – do not use this value, it is not intended for single player quick missions.

**Attack Specific Target** - tells the object to attack whatever target you assign in the parameter. Use the Target Ref # of the specific object.

**Attack Flight Group** - tells the object to attack whatever flight group name you assign in the parameter.

**Change Formation** - changes the flight formation to the one you designate in parameter.

**Helicopter Land** - tells any helicopter that reaches this waypoint to stop and land vertically.

**Escort Flight Group** – tells the flight group to escort another flight group. Once a flight group reaches this waypoint, it will escort the flight group designated in the parameter.

**Parameters** – certain commands will require extra information.

**Patrol for hostiles** – set this flag if you want the aircraft to actively target enemy aircraft while en route.
Short Range Only – at this waypoint, the object will use only short-range weapons.
Long Range Only - at this waypoint, the object will use only long-range weapons.
Any Range - at this waypoint, the object will use all weapons as required.

Taxigroups

If you wish to create a new Taxigroup, select New Group under the Taxigroup menu. Before you select another New Taxigroup, place a taxipoint on the map. This will establish the current taxigroup. You can always move it or add to it at a later time. Taxigroups are used for all Air Objects except helicopters and Harriers.

Unlike Waypoints, the editor screen does not automatically open when you lay down a point. Instead each Taxipoint is defaulted to “Goto Next Point”. You will have to manually open any taxipoints that you wish to change the properties of.

Taxi Point Edit

Taxi Group # - number is used to assign taxigroups to aircraft in their AI Options
Point # - the sequential order of the waypoints in this group.
Action - actions that the object will do once it reaches this taxipoint.
  Goto Next Point – aircraft will head to the next sequential taxipoint.
  Takeoff – tells aircraft to begin takeoff procedure.
  Next Start – same as Goto Next Point, but also informs the next aircraft in formation to begin moving.
Heading – determines the compass heading of the aircraft.
4: Placing Objects

After you have established some waygroups, you can begin placing objects. Objects represent every thing your player’s aircraft can encounter, from enemy planes, ground target buildings to scenery such as trees and water towers. Make certain that you set all of the appropriate variables for every object. Note that for ease of placing multiple objects in the same group, the next object you place will have all of the same attributes except the Group/player ID.

Target Ref # - the tool will assign a unique reference number to every object.
Perm ID – this ID is not relevant for single player quick missions.
Group/player ID – You must consecutively number objects that are part of a group. The Leader must always be zero, all additional Support should be in sequential order thereafter.
Heading – 360 degrees compass heading of the object. (Zero is true north)
Object - select the art appropriate for the object you are representing. This option will be grayed out when you are creating the player.

Format – Aircraft, vehicles, SAM sites, should have Active Radar. Objects with no radar awareness such as buildings should be set to Static.

Base Marker – check this box to have the object appear as an “X” on the Tactical Map (The Tactical Map appears when the player presses F11).

Type – this will determine how other objects will react to this one based on their own AI configurations.

Precise Height – always check this box for ground objects. Do not check it for objects that start in the air.

Height – only objects that start in the air should have this value set above zero. Because topography varies across the map, be careful how low you set air objects, or they may be underground.

Displayed on Map – check this box if you want the object to appear on the Mission Briefing Map.

Icon – If Display on Map is checked, select the Icon that you would like the object to appear as on the Mission Briefing Map.

Ground Object Targeting:

Pre-programmed – allows certain air to ground ordnance such as JDAMs, KAB 500, Mavericks, Keglers and Kedge (T) to lock on to this object as a pre-programmed ground target.

Externally Laser Designated – check if you want semi-active laser guided ordnance such as the Kedge (L), the Karen or the GBU Laser Guided Bombs to target this as a ground object.

Ground Moving Target – for air to surface thermal imaging guidance systems such as the Maverick.

Target is Out to Sea – designating ships as out to sea will increase the range for the Harpoon anti-ship missile.
Click on A.I. >> to go to the next page of Object AI Options

Properties:

**Object Type** – tells the game what type of object this is.
- **Air** - tells the game to treat this object as an aircraft and tells it to follow assigned taxi points if it starts on the ground. Use this for all aircraft including helicopters.
- **Ground Target** - Ground targets will not fire. Use this for all bombing targets.
- **Ground Threat** - Ground threats will fire. Use this for SAMs, AAA, etc.

**AI Type** – depending on object type, this will determine certain AI characteristics such as how the object will fly or how much damage a ground target can withstand.

**Skill** – represents difference between the levels of AI in the frequency in which air objects use flare, chaff, and evasive maneuvering. It may also effect their detection and engagement range. This value is ignored for ground threats and targets.

**Group** – use this group designation for assigning mission goals, formations and way groups. Remember members of a group must have a sequential ID number with the Leader as zero. Also note that the player should always be set to VIPER (F-16) or 300 (MiG-29).

**Rank** – each group has one Leader (which must have its player ID set to zero). All other members of a group should be set to Support.

**Taxigroup Number** – assign aircraft that start on the ground to a Taxigroup.

**Waygroup Number** – assign aircraft in the air and moving ground objects to a way group. You should reserve Waygroup #0 for the player only.

**Formation** – aircraft that are flying as part of a group should also have a Formation.
See Appendix A for what formation each number represents.

Assignment:

**Assignment** - everything under the “Assignment” section of the A.I. Options Window tells the object how to respond to different enemy and friendly aircraft and ground objects.

- **Attack** - The plane will attack any enemies of that type it encounters.
- **Ignore** - the plane will ignore any enemies of that type it encounters.
- **Evade** - the plane will actively evade any enemies of that type it encounters.
- **Protect** - the plane will attack other planes that are targeting friendly of that type.

Conditions:

**Start in Air** - must be selected if your object is starting mid-air.

Other Info:

**AWACS Radar Plane** - tells the game to treat this object as an AWACS. Having an AWACS in any mission will allow the player to have 360 degree radar coverage even if the plane’s radar is turned off.

**Object ignored by AI** - this object will be untouched by enemy and friendly AI.

**Short Ranged Missiles** – Air objects will have short-range missiles such as Sidewinders.

**Long Ranged Missiles** - Air objects will have long-range missiles such as AMRAAMS.

**Bombs** - Air objects will have bombs such as JDAMS.

**Isolate Change** - restricts any changes you have made to that object from affecting the other objects within the same group. You may want to use this button when you place down the first object of a new air or ground group. If you don’t, any changes you make to this new group might effect your previous groups.
5: Editing Mission Details

**Edit Mission:** Select the **Time of Day** when you want the mission to take place. Use the **Mission Loadout** to select the default loadout available to the player. To add a weapon, scroll through the list in **Weapon Type** and type the number of them you want on the aircraft, then press **Add to Mission Loadout**. To remove a weapon, click on the weapon name under **Mission Loadout** and press **Delete Weapon**.

**Edit Mission Text:** Fill in the text that the player will see while on the Mission Briefing screen.

**Edit Mission Goals:** In order to save the scenario, you must have a primary mission goal. Secondary Goals, Bonus Goals and Failure Conditions are all optional. With this tool, you can only select one goal of each type.
6: Saving & Exporting Missions

Select **Save All** under the **File** menu to save your work in progress. It will prompt you to save out an Object file (OBJ), a Resource File (RC) and a Project file (PRJ). For easy retrieval, use the same name for all three.

In order to play the mission, you will need to export it in to an ORF file using **Export** under the **File** menu. The ORF file contains all of the necessary data in one file, which you can play or share with friends. Remember what folder you placed it into.

The program will let you know if you have any errors that would prevent your mission from being playable. To view these errors, please refer to **Section 8: Error Messages**.

At the very least, this is a checklist of things that must be present in your mission:

- 1 Player, correctly configured
- 3 Waypoints for the player with the last 2 being Initial and Final Waypoint
- Primary Mission Goal selected

To play your mission, start the game itself. Select **User Created** on the **Quick Mission** screen. When prompted, select your ORF file.
7: Hints and Tips

1. When editing any ground object such as SAM sites, or other ground forces, make sure that “precise height” is check marked in the “edit object” window.

2. When laying down the player's waypoints, make sure that the final two waypoints are initial approach and final approach, respectively.

3. The flight leader of any flight group must have a group/player ID of 0. This includes the player as well. You must have one and only one flight leader for each one of your flight groups. The flight leader in the game acts as the target selector.

4. When laying down SAM units, make sure to include a SAM radar and the SAM sites under the same group name. The SAMs won't fire unless they have their own radar. Moreover, the SAM radar should always have a radar ID of 0 and the sites should have IDs of 1,2,3, etc.

5. Enemy planes stationed on the ground will not take off unless you give them their own set of taxipoints. Make sure to designate these points in the planes' AI.

6. Try not to mix and match planes of different group names into the same flight formation. Unpredictable things might happen.

7. If you want the enemy flight group to return to its first waypoint after reaching its final waypoint (thereby flying in a loop), under “command type” select “Go to specific Waypoint #”; The “parameter” should automatically be set as waypoint 0.

8. It is important to note that any object you put in the game can be assigned any flight performance. For example, you could make an AN225 cargo plane fly and shoot just like an F-16. The AI type tells the game what type of flight performance to give to any particular object. The F16 performance type, for example, would be faster and more maneuverable than the bomber or cargo plane type. The difference between the helicopter and harrier type is in performance and takeoff. Selecting the harrier type will result in an object capable of taking off like a helicopter but then assuming the speed and maneuverability of a jet. The cargo heli type is similar to the helicopter type, but slower and will not fire.

9. Runways cannot be changed.

10. If you load up your mission in the editor and you don’t see the objects that you just spent the past 2 hours laying down, don’t freak out! Go to the Object menu and check the Display on. This will cure your insanity.
8: Error Messages

When you attempt to save a project you may be warned of errors within your mission. All problematic objects will change to a dark blue color for ease of locating. The errors will also be written to the Error.log file, which can be opened by any text/word browser.

- **warning** = warning written to error.log, ORF file still be generated
- **error** = error written to error.log, ORF file is NOT generated, problem must be fixed

<table>
<thead>
<tr>
<th>Severity</th>
<th>Problem</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>mission data structure</strong></td>
<td></td>
</tr>
<tr>
<td>error</td>
<td>file not referenced in project</td>
</tr>
<tr>
<td><strong>mission loadout, triggers and messages</strong></td>
<td></td>
</tr>
<tr>
<td>error</td>
<td>no Primary Mission Objective, go to Edit Mission Goals</td>
</tr>
<tr>
<td>warning</td>
<td>no messages for Mission Briefing, go to Edit Mission Text</td>
</tr>
<tr>
<td>warning</td>
<td>no weapons selected, go to Edit Mission</td>
</tr>
<tr>
<td>warning</td>
<td>invalid weapon (ex. MiG-29 weapons in F-16 Tool)</td>
</tr>
<tr>
<td><strong>models</strong></td>
<td></td>
</tr>
<tr>
<td>error</td>
<td>number of models used exceeds max number of models</td>
</tr>
<tr>
<td>error</td>
<td>no models</td>
</tr>
<tr>
<td><strong>objects</strong></td>
<td></td>
</tr>
<tr>
<td>error</td>
<td>leader does not have an ID of 0</td>
</tr>
<tr>
<td>error</td>
<td>AI way group assigned to player</td>
</tr>
<tr>
<td>error</td>
<td>no players</td>
</tr>
<tr>
<td>error</td>
<td>more than max number of players</td>
</tr>
<tr>
<td>error</td>
<td>more than one leader per group</td>
</tr>
<tr>
<td>error</td>
<td>flight group doesn’t have a leader</td>
</tr>
<tr>
<td>error</td>
<td>player assigned to improper flight group</td>
</tr>
<tr>
<td>error</td>
<td>flight group must have consecutive ID's</td>
</tr>
<tr>
<td>error</td>
<td>active flight group cannot have move than nine planes</td>
</tr>
<tr>
<td>error</td>
<td>player cannot have more than one wingman</td>
</tr>
<tr>
<td><strong>way_points</strong></td>
<td></td>
</tr>
<tr>
<td>error</td>
<td>no waygroups exist</td>
</tr>
<tr>
<td>error</td>
<td>player waygroup does not have at least three points</td>
</tr>
<tr>
<td>error</td>
<td>last player way point not “Final Approach”</td>
</tr>
<tr>
<td>error</td>
<td>next to last player way point not “Initial Approach”</td>
</tr>
<tr>
<td>error</td>
<td>last A.I. waypoint must be “Goto Specific Waypoint”</td>
</tr>
</tbody>
</table>
Appendix A: Formations

When you assign a plane group to a formation, the Group/player ID number will determine its location. Zero represents the group leader. The examples below are based on a Heading of zero (North).

**FORMATION 0**

![Formation 0 Diagram](image)

**FORMATION 1**

![Formation 1 Diagram](image)